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Time&Budget Plugin for Daylite
About Time&Budget

The reasonable usage of working time is crucial for the economical success of projects
especially for service providers

Daylite assists you to plan and monitor your projects. Based on the Daylite data, Time&Budget
gives you additional control over the costs of your projects. Time&Budget differentiates
between costs resulting from your employees' salaries and third-party costs.

Time&Budget provides you with data to answer the following questions:

* What task generates which costs?

* What employee is involved in which tasks?

* How much time and effort is used for which projects?

* What is my project status and have thresholds been exceeded?

* What third-party costs arose for which projects?

* What billable services have been performed for a given project?

+ What additional services have been performed for which project?

Depending on the industry of your business you have two options of recording your working
hours:

Time Registration and Job & Activity Registration

Appointments are being used for Time Registration.
Tasks are being used for Job & Activity Registration.
Job & Activity Registration

Industries like Design or Prepress often use workflows consisting of a large amount of
individual steps. Time frames and actions of these particular steps can be predetermined.

In this case a Job & Activity Registration is recommended.

A job could be the composition of an article, where you can estimate ahead of time how long
such a job should take. Activities are all actions required to fulfill the job.

Especially jobs with time frames of minutes or few hours require a strict registration of activities
related to the job.

In our Prepress example the 'composition of an article' job could be planned with a one hour
target time using the Job & Activity Registration principle and any amount of activities could
than be registered against it.

An employee starts composing the article and gets interrupted after 20 minutes. The employee
now stops the activity registration of Time&Budget. A 20 minute activity is now linked to the
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unfinished job 'composition of an article'. As soon as the employee resumes the activity, he/she
starts the activity registration again. Once the work is done the employee marks the job as done
in the task registration. Two activities have now been linked to to a job and can subsequently be
analyzed using Time&Budget's reporting tools.

Time Registration

Architects, software developers or consultants often use time registration, as here is being

worked on a few different projects only. With time registration he/she can easily track his/her
time spend on different projects at the end of the working day.

Both methods of tracking time can be used simultaneously.

Concept of Time&Budget

Categories

In Daylite appointments and tasks can be linked with projects and a category can be assigned to
each appointment and each task.

Time&Budget takes advantage of this concept.
Projects as Cost Units and Profit Units
Projects can be either billable customer orders or a pure expense project.

Projects generate costs through in-house working hours as well as through third-party services
and goods.

Opposed to those costs there is the profit (charged price) resulting from billable services.
Example:
A web designer received the customer order to develop a website.

Every activity he/she performs to fullfil the order is being tracked as task or appointment and
linked with the appropriate project. Alternatively he/she could also use activity sets in Daylite.

Time&Budget divides appointment and task categories into four different kinds:
+ Billable Categories
* Non-billable Categories
+ Hidden Categories
* Neutral Categories

Additional information is available in the following chapter.
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Features

+ Track working time easily with Time&Budget Time Registration based on Daylite
appointments

+ To-the-minute recording of activities with Time&Budget Subtask Timer based on Daylite
tasks and subtasks

* Register third party invoices and link them directly with the appropriate project as a PDF
file

+ The Company Summary helps you to keep track of registered working times and to
analyze them by grouping and filtering the data

* Run detailed reports on all activities of projects and opportunities as well as on activities
of people and companies. Choose from internal and external reports with different
feature sets

+ Choose from two different ways to calculate proceeds based on either categories or
hourly rates of Daylite users

+ Define the hourly rates and hourly costs on a per employee basis.

+ Define which appointment and task categories are being used for the analysis. Decide if
a categories are billable, show on internal or external summaries or not being used at all

+ Set time and financial budgets per project

+ Define time and financial thesholds to keep track of your projects

+ Define a factor to facilitate special hourly rates and rebates

+ Define which Daylite users or groups are allowed to use reports or change Time&Budget
preferences

* Run reports on groups of projects, opportunities, people and companies

System Requirements
Operating System: OS X 10.8 or newer

Daylite Version: 4.2 or newer
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Setup
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Installation

1. Time&Budget requires Daylite 4.2 or newer. To check your version open the Daylite menu ->

About Daylite

& N5V CN File Edit

About Daylite
Check for Updates...

View

Preferences... a8,

Superuser Access...

Services >
Hide Daylite 8EH
Hide Others CHEH
Show All

Quit Daylite 260

2. Time&Budget requires OS X 10.8 or newer. To check your OS X version select the Apple menu

-> About this Mac

("8 Daylite File Edit View Plug
About This Mac

System Preferences...

App Store...
Recent ltems >
Force Quit Daylite NOHD
Sleep

Restart...

Shut Down...

Log Out Christopher Tietz... {3Q

3. Open the Time&Budget.dmg file

Time&Budget.dmug

Time&Budget 2 for Daylite
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4. Double click the TimeAndBudget.daylite-plugin file

. .
> 2 Olrjekre {)—

2 -

TimeAndBudget.daylite- Manual
plugin

VISXpert::

| & TimesBudget

5. Install the plug-in by clicking Install

Install plugin
Are you sure you want to install the plugin
‘TimeAndBudget® on this machine?

. Cancel Install

6. To finalize the installation click Restart Daylite.

The plug-in needs to be configured before the first use. More info on the configuration you'll
find in the next chapter Licensing
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Success
Flugin TimeAndBudget' Successfully installed.

Daylite will now restart for the changes to take effect.

Restart Daylite
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Licensing

Without entering a license code you can test Time&Budget during a 14 day trial period.
After this period you will need a license code in order to use the plugin. In order to
purchase Time&Budget, please follow these steps (given the plugin is already installed):

1. Start Daylite

2. In the Daylite menu select Plugins --> Time&Budget --> Preferences...

@ Daylite File Edit View JJENcled Window Help

| NN + New Time Registration...
Subtask Timer...
Time&Budget
fzt Home & Activities Adg Expense.-. 5

i Create Expenses...

» B calendar J

» B contacts Grouping: | Off | @ | B Help >

- About Time&Budget...
v @ Objectives
Ed My Active Projects User Activities between 23 __Preferences..

3. Select the License tab and click Purchase Time&Budget...

Reporting  Users and Teams

Time&Budget - Testphase

During the Time&Budget 14 day trial period you can use Time&Budget
free of charge to full extend

The trial period ends 24.01.2035.

After the end of the trial period you will have to purchase Time&Budget in
order to continue using the plugin.

Purchase Time&Budget...

Close
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4. Select whether you would like to subscribe to Time&Budget as a monthly service or to
purchase it at a single payment.

Reporting  Users and Teams

Time&Budget

Purchase Time&Budget

o at a monthly all-inclusive rate

Subscribe to Time&Budget at $9.90 per Daylite user per month you'll get
Time&Budget including  all future updates and additional reports. The
Time&Budget service may be cancelled on monthly basis.

| at a single payment

Purchase Time&Budget at a single payment of $139 per Daylite user.
Updates required due to major Mac OS5 X or Daylite updates as well as future
additional reports are not included, but may be purchased separately.

Learn more about the difference between the single payment and the Subscription
at a monthly all-inclusive fee...

Back Next

Close

Time&Budget Subscription

If you would like to subscribe to the Time&Budget, please do the following:

Accept the license agreement, click Next and follow the steps on the screen

Reporting  Users and Teams

Time&Budget

You need the Time&Budget subscription for 5 active Daylite users

The subscription may be updated any time and will be in effect immediately

With the subscription of Time&Budget you accept our license agreement

Back MNext

Close

After completing all steps you'll see this window
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Reporting  Users and Teams  Keywords [EETET]

Time&Budget - Subscription

Status: active
User Limit 3
Expiration date: -
Monthly Cost: 28,70 $
Actions

Update subscription

Cancel subscription / Update payment method

Close

Purchase Time&Budget

If you would like to purchase Time&Budget, please do the following:

Accept the license agreement, click Next and follow the steps on the screen

Reporting  Users and Teams [RTTEL

Time&Budget

You need the Time&Budget licenses for 1 active Daylite users.

With the subscription of Time&Budget you accept our license agreement

Back Mext

Close

After completing all steps you'll see this window
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Reporting  Users and Teams [RTTEL

Time&Budget - License overview

Licensed users 1

Actions

Buy more user licenses...

Close
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Preferences
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Define Billable, Non-Billable, Hidden and
Neutral Categories

Billable Categories

Assign billable categories to those tasks and appointments you would like to charge for and
also shall show on a bill of cost.

In our example we're going to use:

+ Consulting
* Programming
* Seminar

Non-billable Categories

In many projects work is being performed that you can't or don't want to charge for.
However, sometimes it makes sense to show the customer on a bill of cost how much work
has been performed free of charge.

Assign non-billable categories to such tasks and appointments.
In our example we're going to use:

« Goodwill
Hidden Categories

There may be tasks and appointments you don't want to put on a bill of costs but you want
them to be registered for internal purposes anyway - time and effort put into marketing or
administration for example.

Hidden categories offer the option to register all auxiliary services, which have been
performed during a project, as tasks or appointments without showing on any external
print layouts.

In our example we're going to use:

« Administration

Time&Budget 2 for Daylite Page 16



* Marketing
Neutral Categories

In addition to the already mentioned categories there may be tasks and appointments that
are neither billable nor supposed to show on any internal or external document.

In our example we're going to use:

* Private
* Vacation

Calculation of Proceeds and Charged Prices Respectively)

Many reports in Time&Budget calculate not just the costs of registered activities but also
the proceeds and the charged price respectively (shown as Charge and Charge/h in reports)
Proceeds and charged prices are being calculated only if a category has been classified as
"billable".

Time&Budget differentiates between two different ways to calculate proceeds:
1. Calculation of proceeds based on hourly rates of an employee

Select "Calculate proceeds based on User charges" to get proceeds calculated based on the
hourly rates assigned to a particular Daylite user. The proceeds of every billable activity will
be calculated dependent on the participants of an appointment or the user responsible for
a task.

2. Calculation of proceeds based on categories

Select "Calculate proceeds based on Category" to get proceeds calculated based on rates
assigned to a particular category. Proceeds will be calculated dependent on the category of
a particular billable activity.

In order to define the categories and Time&Budgets interpretation thereof, please follow these
steps:

1. Start Daylite

2. Navigate to the Daylite menu Plug-Ins -> Time&Budget -> Preferences
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@ Daylite File Edit View JEIL:H Window Help

@ + New BaEucge Time Registration...
Subtask Timer...
Time&Budget
it Home & Activities G EXpEa= 3
1 Create Expenses... ]
» [F] calendar ]
» |3 contacts Grouping: | Off | @ | B Help >
~  About Time&Budget...
¥ & Objectives
Ed My Active Projects User Activities between 23__Preferences...

3. Select the Reporting tab
(1) Define the extra fields used for the financial and time budget within projects

Please note: (to configure extra fields, navigate to the Daylite preferences -> Custom Fields ->
Projects)

(2) Check the appropriate boxes to determine if tasks, appointments and hourly rates shall be
used with reports. You can also define here whether future appointments are being taken into
consideration. Also define whether the project name shall be changed to !! Project Name if the
project exceeds the budget to alleviate filtering for critical projects.

(3) Determine for tasks and appointments separately, which categories are billable, non-billable,
hidden or neutral

(4) Determine whether appointments added via the Time Registration dialog are being added to
the particular Daylite pipeline stage

FEILl(LIvI Users and Teams  License

Project Extra Fields Category Reporting Options
Budget finanzbudget o @ Appointments ?
Time Budget Zeitbudget 5 Name Reporting Proceeds / h Force Linking
Ri ing Billable Time Budget lecti z . m - © ¢ n
emain able Time Budget no selection & . . f B\
g g @ Administration (oo (& O
@ Consulting (@@ [0
@ Items to Include in Reporting © Development ‘ 120,00 €
Tk @ Coodwil (@ ool &) O
asks ] @ Internal @lac[o[&) O
Ignore durations longer than 480 minutes ® KPI \l D
i 1 K
Appointments R arketing (@ & (V]
! ® Privat @oo[&) O
"] Exclude appointments in future in budget summaries - 5
® Sales (@ ool &) O
@ Support (e ool &) O
Project Settings
Default budget mode for new projects
Month z
Add '!!" prefix to project name for budget overrun
Q Calculate proceeds based on ()
Time registration settings b (_)User charges
o © Category
Add appointments in pipelinestage
Close
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Initial Settings to Calculate Proceeds (Charged Price)

(1) Set proceeds and charged prices respectively for individual categories

(2) Select if linking with an objective is mandatory when recording activities with Time

Registration and Subtask Timer

(3) Select whether the proceeds are being calculated based on hourly rates of Daylite users or
based on categories (independent from the user's hourly rate)

Project Extra Fields

Financial Budget finanzbudget

Time Budget Zeitbudget

< < O

Remaing Billable Time Budget no selection

Items to Include in Reporting

Tasks

Ignore durations longer than 480 minutes

Appointments

) Exclude appointments in future in budget summaries

Project Settings
Default budget mode for new projects

~

Maonth &5

Add '!!' prefix to project name for budget overrun

Time registration settings

Add appointments in pipelinestage

©

[ X Non N N N NN ION N ¥ |

Users and Teams

MName
‘Accommeodation
Administration
Consulting
Development
Goodwill
Heliday
Internal
Marketing
Privat
Sales
Seminar
Support
Vaccation

Calculate proceeds based on

Classification of Categories

This table depicts the four reporting

classifications and their functions in respect of

visibility, cost and profit generation

reporting classification @ - @

visible
visible in external reports

in internal reports

generates costs
generates direct profit

¥ oOox

x
x
x
x

License

Category Reporting Options

IEEEM  Appointments o
—

Reporting
(OO [&]
(0@ 0@
(@@ 0@
(oTa &)
@i 0o
@ic 0 &)
(O O[&]
@igo[&)
(o] ol &)
(@@ 0@
(@@ IO
@ialole)

(") User charges
O Category

e -

Force Linking

Proceeds / h

150,00 €
120,00 €

<J<Imimy < Imimy <Y< J<<]<]

120,00 €

Close

Time&Budget 2 for Daylite
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Hourly Rates

External and internal hourly rates

In the Time&Budget preferences you can set the hourly wage of a Daylite user (internal
rate) and the hourly rate a client is being charged with (external rate, profit, charged price

and sales price respectively)

Internal rates are being added to the costs of a project, the external rates are being added

to the profit of a project as long "Calculate proceeds based on User charges" has been
selected. (see Define Billable, Non-Billable, Hidden and Neutral Categories)

1. Start Daylite

2. Navigate to the Daylite menu Plugins -> Time&Budget -> Preferences

@ Daylite File Edit View JEIL:H Window Help

3. Select the Users and Teams tab

@ + New BaEucge Time Registration...
i Subtask Timer...
Time&Budget
m —_ & Activities SRR —— 3

I Create Expenses...

» [F] calendar J

» L contacts Grouping: | Off | @ | B Help

- About Time&Budget...
¥ & Objectives
Ed My Active Projects User Activities between 23__Preferences...

Time&Budget 2 for Daylite
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Team Permissions

Team Allowed to View Reports and Print
Layouts

All
Team Allowed to View Critical Data

Administration

Team Allowed to Change Preferences

Manager

Cost and Charges

Lizar Hourly Cost
Bennie Brown Hourly Charge
Dawn Klein

Kendra Montgomery

Kevin Gregory

<>

<>

<>

40,00 €

150,00 €

Close

Here you can set the permissions of Daylite teams as well as the internal and external rates of

particular Daylite users.

(1) Select the Daylite user for whom you'd like to set the hourly rates

(2) Enter the hourly wage of the Daylite user (internal rate)

(3) Enter the hourly charge (external rate)

User e Hourly Cost €40,00

Bennie Brown

Dawn Klein ) Hourly Charge | €150,00

Jose Miller

Kendra Montgomery
Kevin Gregory

In our example shown here:

Cost and Charges

Close

Harold Leary's hourly wage is $40, the customer is being charged $150 per hour.

Time&Budget 2 for Daylite
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Permissions

The Time&Budget permissions define which Daylite team is allowed to use reports and
print layouts, which team is allowed to view critical data (costs and profit) and which team is
allowed to view and change Time&Budget preferences.

1. Start Daylite
2. Navigate to the Daylite menu Plugins -> Time&Budget -> Preferences

@ Daylite File Edit View Window Help

[ NON + New BaBudge Time Registration...
: Subtask Timer...
Time&Budget
fzt Home & Activities ACK EXpis=. 5

i Create Expenses...

» B calendar ]

» B contacts Grouping: | Off | @ | B Help >

- About Time&Budget...
v @ Objectives
Ed My Active Projects User Activities between 23.._Preferences... I

3. Select the Users and Teams tab

Team Permissions Cnst. and Chargés
Team Allowed to View Reports and Print User Huurly Cost €25 00 I
Leyouts |

- Dawn Klein Hourly Charge €120,00
All w .
- Jose Miller

Team Allowed to View Critical Data Kendra Muntgomery

Administration & Kevin Gregory

Team Allowed to Change Preferences

L]

Manager

Close
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Determine:

(1) - which Daylite Team is allowed to use reports and print layouts

(2) - which Daylite Team is allowed to view critical data (costs and profit)
(3) - which Daylite Team is allowed to change the plugin preferences

In order to create new teams, navigate to the Daylite preferences Users & Teams -> Teams
Team Permissions

Team Allowed to View Reports and Print
Layouts

O «

Team Allowed to View Critical Data

° Administration

Team Allowed to Change Preferences

o Manager

L]

L]

L]

In our example shown here:

The whole Daylite team is allowed to use reports and print layouts. Team 'Administration’ has
access to critical data and the plugin preferences. 'Manager' is the only team allowed to access
and change preferences.

Time&Budget 2 for Daylite Page 23



Budget Settings

The budget settings are accessible from any Time&Budget tab in Daylite projects,
opportunities, companies and people.

Budget Settings

1. To access the budget settings, click the Time&Budget tab and click the cog wheel

e0e + New Project i Ht ®m e B O E I Q Search
Al Projects Time&Budget [+
4} Home Arranged by Created Q | Project Progress  Time&Budget & +-
> B Calendar Fraparation < & Project-Report timeframe: None ¢ @ =]
e Busi Itancy Moonlight... @
usiness consultancy Moonlight...
v @ Objectives Grouping: ‘ of | % m A e B & e
B4 My Active Projects ‘Seminar "Selling to decision maker"
A it o : :
Ed My Aotive Opportu... | Acuisition Craig Rogers - Consulting
g LBy ‘Webinterface for Johnson's Servi... @
All Opportunti N
e Delivery Financial Summary
» £ My objectives
T, Suspendst g Inuxiuusl training Sutton
owor
T, Finished next 7 days Afforded Time 287,50 €
T,
{0panBriacis Mocarthy & Go - Website develop... @ Expenses 0.00€
©. opan ohances Total 267,50 €
©; Lost chances Lois Frank Auditor - Consulting .
P & Tasks Realization Time Summary
» [& Notes & Email
— !l Seminar for Jenkins & Partner
» 5 Forms Billable Time consumed 400h
Nen Billable Time consumed 400h
* 1@ Groups Raquel Bush Management - Seminar
© Fopors Activities —
© TimeaBudget FLMH Brown - Consulting .
Postprocessing
Cralg Rogers - Consulting — Category — Name — Keywords — User — Person — Company — Opportunity — Date » Duri
Fine-tuning
Training course for Young Manag...
Administration  Paul Johannes - Jdose 20.04.15
Consuilting: Prepare Miler
J.Lee Business Consultancy - Se... ®© Duwmen?s amp
Rework -
Coneept/Content
‘Wanda Dennis Tax Consultancy -...
Rework © Administration  Paul Johannes - Jose 27.04.15
Consuiting: Settle Miler
Pedro Bowman - Consulting ) Appointment
Postprocessing
T T | Admiristration  Consifting Jose Dawn  Jose Miler  Moonight 25.08.15

(1) Determine which timeframe is being used for the calculation

Please note: please make sure to set the Budget Mode according to the selected timeframe
(2) Financial budget

(3) Contribution margin

(4) Time budget

(5) Charge factor (to facilitate special hourly rates and rebates)

(6) Time thesholds
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(7) Financial thresholds

Please note: the time & financial budgets themselves are being considered to be thresholds.
The thresholds can be set to be either a percentage or the corresponding unit (hour or
currency)

# O
Settings
Budgets
Budget Mode | fixed
Financial Budget | 1.050,00 €|
Margin | 300,00 €|
Time Budget | 19h)
Charge factor 100 %
" . |
Financial Thresholds
Threshold 1 | 80 % |
Threshold 2 | 120 %
Unit | %
Applies to | All Activities
Time Thresholds
Threshold 1 | 60 % |
Threshold 2 | 80 %
Unit | %
Applies to | All Activities
Save
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Time Registration

Time&Budget 2 for Daylite Page 26



Time Registration

Time Registration offers the options to create appointments from scratch or to copy over
task titles from worklist or project tasks to a new appointment.

1. Click this icon to open the Time Registration

Bl B I E lu Q, Search

General

(1) Appointment schedule

(2) Add new appointment

[ JoN ] Time Registration (e
T e | B O 2o < Toay > @ o
Name Subject Category Start End

[T] Finish Annual Settlement
D Adjust appointment with Rudolph Gragoery
D Contact new Customer and occupy an appeintment

D individual education Bowman : reply open guestions

Total Time: Delete
o Add Appeintment
Subject || |

Start 08:00 End 09:00 Duration 01:00
Category @ Internal &5

Links | Add Link |

Keywords | Add Keyword |
Invitees | Add Invitee |

A0 e f

Details

Clear Content Add

Appointment Schedule

(1) Show Daylite worklist to copy over task titles to a new appointment

(2) Use the arrows to navigate back and forth between particular days. Click Today to get back
to the current date
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(3) Show details of an appointment selected in the appointment schedule (4)

(4) Appointment schedule of selected day

(5) Delete a selected appointment

(6) Displays the total duration of all appointments registered via Time&Budget (depends on

categories and the Time&Budget preferences)

[ NN Time Registration o ef:h
= o 10 Mar 2015 { Today > [& o
Subject Category Start End
H&P Consulting - Appointrmen Consulting
Fresentation appointment @ Sales = 11:00 12:30
Closing-Meeting Ms. Dennis ® Consulting 2 13:45 15:45

ngtal Time: & hours 30 minutes e Delete

Add Appointment

Add Appointments

For the new appointment you can

(1) - enter a title

(2) - enter start time, end time and/or duration
(3) - select appropriate category

(4) - link to Daylite objects

(5) - select keywords

(6) - add invitees

(7) - enter appointment details

(8) Reset all fields

(9) Create appointment

Time&Budget 2 for Daylite
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Subject o

Start 11:00 End 12:00 o Duration 01:00

Category @ Internal °¢
Links | Add Link o

Keywords | Add Keyword ;e

Invitees | Add Invitee ;o
Details o

o Clear Content o Add

Edit Appointments
(1) Show appointment details

(2) Edit these right in Time&Budget

Time Registration

@ |
(")

B 10 Mar 2015 < Today > Appointment  Activity & +-
Subject Category Start End .
H&P Consulting - Appointmen Consulting @ H&P Consulting -
Appointment
Presentation appointment @ Sales ko 11:00 12:30
Closing-Meeting Ms. Dennis @ Consulting < 13:45 15:45 category @ Consulting
starts 10/ 3/2015 09:00
duration 2 hours
ends 10/ 3/2015 11:00
timezene Central European Time
show as  Busy
Total Time: 5 hours 30 minutes Delete my status @ Accepted Decline...
invitees @ (@ Jose Miller | »
QR el linked | B8 H & P Communication A... |»
AL Jerry Price |»
Subject
r 1 r 1 r 1 type Appointment
Start 11:00 End 12:00 Duration 01:00
status Confirmed
Category @ Consulting <
owner Jose Miller
Links | Add Link |
created Jose Miller
Ki ords | Add K ord |
s \Add Reyword 12 Mar 2015 12:34
Invitees | Add Invitee | modified Today 17:38
Details
Clear Content Add Edit o

Usage of Time Registration in Conjunction with Daylite Worklist

(1) Show/hide Daylite Worklist
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(2) Select a task

(3) Add the time recorded for a particular task as an appointment. The appointment can be
edited as described here.

Please note: the duration of the appointment is being determined by the cumulated duration of
all recorded timeframes / subtasks

o ® Time Registration o}
T Projects B0 over2s < Today > B 0O
Name Subject Category Start End
B Finish Annual Settlement H&P Consulting - Appointmen [ ] Consulting < 09:00 11:00
[[] Adjust appointmant with Rudolph Gregory Presentation appointment @ sales fo] 11:00 12:30
D Contast new Customer and cocupy an appolntment Closing-Meeting Ms. Dennis @ Consulting < 13:45 1545
D individual education Bowman : reply open questions
Total Time: 5 hours 30 minutes Delete
o Add Appointment
Subject | Finish Annual Settlement
Start 11:00 End 12:00 Duration 01:00
Category @ Internal =

<
Links | # Finish Annual Settlement | | Ba Moonlight Inc. ' | Add Link |
Keywords | Add Keyword |
Invitees | Add Invitee |

Details

Clear Content Add

Usage of Time Registration in Conjunction with Daylite Projects
(1) Show Daylite worklist (as described here) and select the Project tab

(2) Use existing lists and smart lists to structure and select your tasks quicker

(3) Select a project or expand it in order to select the linked task

(4) Add recorded time as an appointment in Time Registration. This works as described here.
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=]

[ JoN ] Time Registration
u J
| I Worklist - Projects B 4. Mai 2015
My active Projects Subject Category

H&P Final discussion

Consulting

g T Pl individual training Sutton

Marketi s
T Il Mccarthy & Co - Website development @ Marketing

‘Seminar for Mrs Martinez: Teil

T Business consultancy Moonlight Consult Ltd
T ¥Craig Rogers - Consulting

[~ P Paul Johannes - Consulting: Settle Ap...
(]} ¥ Paul Johannes - Censulting: Prepare...

T FLMH Brown - Consulting

T » Seminar "Selling to decision maker"

T P Seminar for Mrs Martinez

Total Time: 2 hours

Add Appointment

< Today > B O

Start End

10:00 11:00
14:00 15:00
Delete

gsmm |
Start 11:00 End 11:30

Category @ Accommodation

Links | + Add Link |

Keywords | + Add Keyword |
Invitees | + Add Invitee |

Details

Clear Content Add

Duration 00:30

Data Quality

When recording an activity with Time Registration, Time&Budget checks whether the selected

category requires linking with an objective (see

Define Billable, Non-Billable, Hidden and

Neutral Categories (Initial Settings to Calculate Proceeds). If linking is mandatory but no link has
been provided yet, Time&Budget prompts you to do so.

oee Time Registration =]
= Please link this appointment to an B o
. objectivel
Subject End
[ we o)

m B e y— s

Total 1 elete

T Training course for Young

] Management Consultancy
g category Seminar 10:30
Gaty status Deferred ¢
f| due Yesterday
Keyw
Invit
Details
Clear Content Add
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Subtask Timer

Subtask Timer provides a on-the-minute recording of jobs and activities. This is being done

by the automated creation of subtasks in Daylite.

1. Click this icon to open the Subtask Timer

Ble|B O E lu Q, Search

Overview

(1) Start time recording for task selected from your worklist (5)

(2) Pause time registration for selected task

(3) Stop time registration for selected task and mark selected as done
(4) Use the search to add tasks to your worklist (5)

(5) Tasks from Daylite worklist

(6) Add or remove tasks

(7) Subtask overview

(8) Remove selected subtasks

(9) Edit selected subtasks
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[ JoN | Subtask Timer (="

Paul Johannes - Consulting: Prepare Documents and Con...

% @ T Craig Rogers - Consulting @
] 00:43:00 v

Q, Search Task |

Worklist

— Title Dur.
[C] work on Concept 0:00

B Faul Johannes - Consuilting: Prepare Documents a

[C] Call Customer
[[] «call the new customers and fill out the form 0:00
[[] to follow up call 0:00

&
Subtasks for Selected Task
Title Start End Dur.
Prepare Documents 08.05.15 16:12 18:55 0:43
Work on Concept 08.05.15 16:13 0:00

=l - ) @9
T —

Register Tasks

If a task is being completed in several steps, Subtask Timer creates subtasks
The default title of such a subtask is Recorded by Subtask Timer.
Title and details of tasks and subtask can be edited by clicking the Pencil icon.

Recorded times are being rounded up to the next minute.
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o0 e Subtask Timer

=]

T Craig Rogers - Consulting

> 00:43:00

v

Paul Johannes - Consulting: Prepare Documents and Con...

[ Q, Search Task

Worklist
Title Dur.
[C] work on Concept 0:00
[[] Paul -G Prepare Dt 0:43
[] Call Customer 0:00
[[] call the new customers and fill eut the form 0:00
[] to follow up call 0:00
I8+
I Prepare Documents
= L4 El Details
Subtasks for Selected Task # (T Graig Rogers - Consulting |»)
Title Start End  Dur. {3 Aad Link )
Prepare Documents 08.05.15 16:12 16:55 0:43 = Mone:
e 5
Work on Gancept 08.05.15 16:13 0:00 o |+ Add Keywerd
< M 8 52015 @
type ToDos
El E location Location
status [v| Done +
Deone
| Close |
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Cost Registration
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Registration of Third-Party Costs

Beside the work that is being performed, there are also costs involved in a project for
example, when goods and services are being purchased from third parties. This also applies
to travel and other expenses.

Time&Budget makes it possible to register those third-party costs and to link them with a
project. This enables you to analyze the entire costs of a project.

Please note: the following instructions also apply to opportunities, people and companies.
To simplify matters, the following refers solely to projects.

Registration of Third-Party Costs

1. Take a click on this icon to open to Add Expenses

Please note: It is possible to add this function to the contextual menu in the Daylite preferences

m @ [ E I Q, Search

(1) Add information like title, invoice number and total amount as well as linked objectives,
keywords and details

(2) If you have added a receipt or invoice as a PDF file, you will see a preview here

Please note: the available keywords are the Daylite keywords for notes
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[ JoN ) Add Expense

. [r—
E] Invoice
b e Farmms L
] [l -
Sy esarram o smmm
inv. number Invoice Number e i e et
amount 99,00 €
charge 120,00 € e
invoice date 7. 5.2015
due date Due Date ._M' \ ',“' l:. ;
[ [
pay date Pay Date et ' w =
mses | nEn
assigned to  Jose Miller 3 e sz
readee  men
Py
supplier ( + Select Company".l
. St a2 e e
objectives (T Craig Rogers - Consulting |r_il R S P S —
S [——
receipts 4 Add File
keywords (+ Add Keyword ]
annotations Annotations e e e e et e s

Usage of the Drop Zone

Thanks to the comfortable drop zone, documents can be added by simply dragging it onto the
drop zone.

(1) Open the preview pane

(2) Drag & drop a document (e.g a PDF file of an invoice or a receipt) onto the preview pane. The
document will now be added to Daylite and liked with the expenses details.
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inv. number Invoice Number
amount 0,00 %
charge 0,00%
invoice date 8. 5.2015
due date Due Date

pay date Pay Date

Drag receipt here...

assigned to  Jose Miller 3
ier |+ Select G )
bjecti T Lois Frank Auditor - C v

( + Add Objective |
recelpts (+ Add File )

keywords (+ Add Keyword ]

annotations Annotations

Access Previously Registered Third-Party Costs

Registered third-party costs are being saved as a note with the category "Expense" A special
view (tab) facilitates access and changes to the registered data.

(1) To edit registered expenses, click the name of the expense in a Time&Budget report

(2) Select the Expenses tab in the following slide-over an edit the expense and access passible
documents
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Please note: Another way to access and edit registered expenses is by selecting Notes & Email
in the Daylite side bar and filtering the category Expenses and a particular project.

Q Search

...@+ng ‘L@

(~ B CRE - B —
-imno‘m] of the following Save as Smart List | [+ (=]
[contains | BEE

g |
((category S lis_c||Expense o) S]]
+ DEE

£} Home Arranged by Created + Q
» [ Calendar
» B contacts Invoice Heute
» & Objectives ®
P o Tasks
¥ [ Notes & Email

[=] Email
=, E-Mails about DMI

» B Forms
v I§ Groups
IE] Al Groups
@& Reports
@ Time&Budget

No Selection
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Time&Budget Tab

The Time&Budget Tab

See the effort/revenue ratio on people, companies, projects and opportunities at a glance.

In our example we show just companies and projects

Time&Budget Tab

1. Select a person, a company, an opportunity or a project in Daylite and select
theTime&Budget tab

®@0® - NewPojeot v | e m e c@ O EBESEM Q Search
Al Projects | +
Arranged by Created + Q | Project Progress |_Time&Budget | & +-
Praperation : .
" . All Activity *
T‘ Craig Rogers - Consulting ty Q
Business consultancy Moonlight... @ r Now
category @ Gonsulting
Seminar "Selling to decision maker" status Now Yesterday
Acquisition h
B Invoice Yesterday
start 14, 3.2015
Webinterface for Johnson's Servi... o Jose Miller 18:58
Dellvery people L Craig Rogers | ») Patron & MusterBasicipg
:;::xid"a' fraining Sutton companies ( Ha Craig Rogers |») Patron B involice Yesterday
Jose Miller 18:57
opportunity | © Craig Rogers - Gonsulting | »
Mccarthy & Co - Website develop... © # MusterBasicing

finanzbudget  3.500
Lois Frank Auditor - Consulting ® Earlier This Year

Realization owner Jose Miller

@ Paul Joh; - Prepare and Concept/ 29. Apr. 2015
created Jose Miller Content 14:00
11 Seminar for Jenkins & Partner 2. Mai 2015 10105
modified Gestern 18:58 B Fine-tuning 27. Apr. 2015
Consulting 15:82
Raquel Bush Management - Seminar
B Consulting 27. Apr. 2015
FLMH Brown - Consulting ° 16:32
Postpracessing
B 27. Apr. 2015
Cralg Rogers - Gonsulting 16:32
Fine-tuning
@ Paul Joh - Settle 27. Apr. 2015
Training course for Young Manag... e
2] Jose Joh, - : Inhalte und an 25. Mérz 2015
J.Lee Business Consultancy - Se... T Kunden versenden 15:30
Rework : [
P Nachbearbeitung 25. Mérz 2015
Wanda Dennis Tax Consultancy -... Gonsutting 15:13
Rework: b
@ Consulting Jose Rogers 24. Mérz 2015
Pedro Bowman - Consulting ° r 11:00
Postprocessing
@ Consulting Jose Rogers 17. Mérz 2015
15 items Edit L 16:00

Company Overview

(1) Back & forward

(2) Refresh

(3) Select between an internal or external summary
(4) Select a timeframe

(5) Determine the Budget Settings
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(6) Print current view
(7) Group by different Daylite objects
(8) Financial summary

(9) Time summary

®©®® +NewCompany ~ | 0 e me ¢ 0 EE n Q Search
Companies ‘ +
Aranged by Company ID # Q Cu@y_mhll Q w
Pedro Bowman ° & Gompany - Report & [ timeframe: Weck ¢ Nr. 13,23.00.15 - 29.03.15 { Today > ] [ # o
San Fancisco
Graig Rogers of o [0 ¢ =27 o |@ w[a]e
Los Angeles
s Tax Gonsultancy Wanda Dennis Tax Consultancy
Timeframe: 23.03.2015 - 29.03.2015
Mccarthy & Go Inc. Accountancy Firm °
New York Ci "
lew York City Financial Summary

William's Publicity Agency PY
New York City

Budget per week 100,00 $ 100,00 §
Jenkins & Partner ° Afforded Time: 185,005
San Fancisco Expenses 0008 @
Peterson & Partner Communication Agency g Remaining 85006
Los Angeles !
Gooper Gompany °
New York City

185.00 $

Pmela Reed - GoachingConcepts °
New York City Time Summary
Judith Davis Tax Consultancy °
New York City Time Budget per week 500h

Billable Ti ed 3:00h
J. Jones Coaching ° @ Time consum
New York Gity Billable Time Remaining 200h @
Jones Business Communication Agency ° Non Billable Time consumed 300h
New York City

Total Time Remaining -1:00h
Parker & Partner Tax Consultancy Firm °
Panketal
Hexabinaer Gommunication Agency @ | Activities Export
New York City
Julio Hamilton Inc. °
San Fancisco — Category — Name — Keywords — User — Person —  Project — Opportunity — Date w Duration — GCost — Charge — Billed —
Moore Consult LTD - 600 18500%  360,00%

76 items .

Project Overview

1. Select a Daylite project and click the Time&Budget tab
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Project  Progress [m & -

. o .o All Activity +
T Individual training Sutton ty Q
=3 Later Today
't ) Semil
categony L seminar ml training Sutton: get feedbach 9 Mar 2015
status In Progress Bennie Brown
due 12/ 3/2015 m| : reply open questions 6 Mar 2015
start 13/ 2/2015 Jose Miller
people | L Jamie Sutton | ») Patron 7 APR 2015 Now
(@ Jose Miller [») @ Coach / Trai -
oz Miller [+) @ Coach / Trainer Earlier This Year
companies | §s Jamie Sutton M.Ba Tax Cons... |n-2- Seminar - Individual training Sutton 4 Apr 2015
Patron 10:00
( Ee Moonlight Inc. [») @ O
@ Seminar - Individual training Sutton 4 Apr 2015
groups | [ My Project | ») 10:00
finanzbudget  1.200 @ Appointment with Mrs. Sutton 12 Mar 2015
09:00
owner Jose Miller r wants to know something about the project
created Jose Miller &) Seminar - Individual Training Sutton 5 Mar 2015
20 Feb 2015 12:16 L 10:00
modified Today 1&:14 C
r @ Individula training Sutton : create Moderation 4 Mar 2015
L 11:00
IE] My Project 2 Mar 2015
: @ Individual training Sutton: clarify technical 2 Mar 2015
= circumstances 11:00
: @ Individual training Sutton: Information about 26 Feb 2015
- participants 09:45
[+ Individual trainning Sutton: Book Hotel 19 Feb 2015
— Kendra Montgomery 10:50
Edit -

Internal Project Summary
Select Internal Project Summary
(1) Group objects of the report

It is possible to group and filter your data as desired. More details are available in chapter
Global.

®@0® +NewPoject v 0 e e s ¢ O EBEI= Q Search
My Active Projects ‘ +
Arranged by Due Date & Q | Project Progress Time&Budget & +-
Il Individual training Sutton o & Project-Report ¢ timeframe:  None © #* O
Rewerk o
Seminar for Mrs Martinez o Gowing: | Of | % @ L He ]g & & e
Preperation o
Seminar *Selling to decisionma... - | Craig Rogers - Consulting
Acquisition o
Business consultancy Mooniigh... @ | 'inancial Summary
i Fixed Budget 3.500,00 §
Margin -2.500,00 $ 2.625,00'5
Afforded Time - 207,50
Expenses -99,008
Remaining 613,50 %
3.500,00 5
386.50 §
Time Summary
Billable Time consumed 4:00 h
Non Bilzble Time consumed 400h
Activities Export...
— Category — Name — Keywords — User — Person — Company — Opportunity — Date v Cost — Charge — Billed —
386,505 720008
5 tems | =] Expense Invoice Jose 07.05.15
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External Project Summary

Select External Project Summary

(1) Determine timeframe

(2) Print displayed report any time to hand out to a client

(3) Click to export table

(4) Click to transfer data to connected invoicing system

®@0® +MNewProject v 0 e mes ¢c® O EBEE L Q Search

My Active Projects ‘ +
Arranged by Due Date * Q | Project Progress Time&Budget ygv
!l Individual training Sutton o < & Project - Print Layout < @ timeframe:  Year < 2018 < Today > ] [ *

Rework
Mondschein GmbH

Seminar for Mrs Martinez - Blutenburgstrase 35
Preperation - 80636 Minchen
5 i Deutschiand
Seminar *Selling to decision ma... - M d
cquisition - P e

Business consultancy Moonligh... @

Activities for Craig Rogers - Consulting 8. Mai 2015
Craig Rogers - Gonsuilting @ | Timeframe: 0101.2015 - 31.12.2015
Fine-tuning
Financial Summary
Financial Budget 3.500,00 $
Consumed 720,00$
Remaining 2.780,00%

Time Summary

Time Budget 0:00h
Consumed 4:00 h
Remaining 0:00 h

e © o

Activities Export... || Invoice... || Settings...
Activity Category Owner Date Duration Cost Charge Billed
| @ Invoice Expense Jose Miller 07.05.15 - 18:57 99,00 § 120,00 § (]
| (© Consutting Jose Rogers Consutting Dawn Kein 24.08.15-11:00 200 7000$ 300,00$ o
| ® Consulting Jose Rogers Consulting Dawn Klein 17.03.15 - 16:00 2:00 70,008 300,00 0
4:00 239,008 720,008

Planned and Actual Time
Select the Planned and Actual Time report

(1) Based on a task's estimated duration (a standard Daylite functionality, available in the task
edit card), this report shows the total amount of the project's estimated time. The report groups
the result by pipeline stage and parent task.

(2) If you have used Time&Budget's Subtask Timer, the recorded time will be offset against the
estimated time. This gives you a target-performance comparison to keep track of your projects.

(3) Grouping is based on project pipeline stages, parent tasks and subtasks respectively. This
provides you with a target-performance comparison in any desired level of detail.
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Armanged by Due Date Q| Project Progress  Time&Budget

& +

It Individual training Sutton
i

o | 1>

> & Planned and Actu... $

L * o

Seminar for Mrs Martinez
Preperation

Seminar "Selling to decision ma...
Acquisition

Business consultancy Moonligh... @

v

-, | Craig Rogers - Consulting

Estimated Time (®:20n)
Recorded Time 112h
Estimated Time Remaining 508h

created on 08.05.2015

| Mecnenis

B Fine-tuning (6:20) 112
» | ¥ Paul Johannes - Consulting: Settie Appointment (0:20) 029
¥ | ¥ Paul Johannes - Consulting: Prepare Documents and Congept/Content (6:00)  0:43
+ Prepare Documents (1:00) 043
~ Work on Concept (2:00)  0:00
’ B Realization ‘
’ B Postprocessing
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Global

See your business from a different perspective.

Get a summary of all activities (including third-party costs), as well as an overview of project

thresholds and data quality.

Select Time&Budget from the Daylite sidebar.

ece + New a @ 8§ ¢ @ O OO Q Search
Home 4
£} Home
» B Calendar 8 Mai 2015 Due Today Mittwoch, 13. Mal
» [ contacts Fre|tag Work on Goncept Debra Brewer's Birthday
B Graig Rogers - Gonsulting
» @ Objectives
all-day Theresa Nelson's Birthday ]
: il Paul Johannes - Gonsulting: Prepare Documents and Concept/... Freitag, 15. Mal
PO Folix Lyons's Birthday # Craig Rogers - Gonsulting
» I8 Notes & Email 8:00 Miller - Vaccation
mal Gall Customer hone All-day
» [ Forms. Craig Rogers - Consulting
v I Groups oo Overdue Jean Green's Birthday
IE] All Groups
© roports ‘Seminar for Mrs Martinez 5. Mal
10:00
Time&B: et
Businassconsutary pat 2 Moors Gonsat 704 v
Show more...
11:00
Workiist +
12:00
No Tasks

13:00

14:00

15:00

16:00

17:00

18:00

Activities

(1) Select report

(2) Select timeframe
(3) Print current view
(4) Back & forward
(5) Refresh

(6) Group shown objects
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[ JEX ] + New Q e mwcE I Q Search
oo o — o
fa} Home < & Activities ® Q{m-hm.: Month & April 2015 { Today ) @ 4
» B calendar
» [l contacts [ Grouping: El * = L B T | O ]@ -2
» & Objectives
P o Tasks User Activities between 01.04.2015 and 30.04.2015 created on 08.05.2015
=
> B otes & Emai Timeframe: 01.04.2015 - 30.04.2015
» [ Forms.
v I Groups Chart
IEJ Al Groups.
© repons No chart avallable
@ Time&Budget -
Activities Export...
— Category —  Name — Keywords — User —  Person — Company — Project — Opportunity — Date v Duration — Cost — Charge — Billed —
184:41 5993088 11075008
(© Gonsuting H&P Gonsulting JoseMiler  Jerry Price H & P Communication Agency 30,0415 130 60,008 225008
Sales Presentation Jose Miller 30.0415 200 80,008
appointment
Consuting Consulting Johnny Lee Jose Miler  Johnny Lee J.Lee Business Consultancy 30.04.15 130 60,008 225005
-Pan2
Administration  Seminar for Mrs Jose Miller Seminar for 30.04.15 100 40,008
® Martinez: Create overall Mrs Martinez
economic plan
Accommodation  Appaintment with Mrs. Jose Miler  Jamie Jamie Sutton M.Ba Tax 1l Individual 30,0415 100 40,008
© Sutton Sutton Consultancy training
sutton
Administration  Hartung Consult DawnKlein  Jose Miller, ~ Moonlight Inc., Moore Consult  Business 20.04.15 100 35008
© GmbH;: summarize the Eugene LD consultancy
topics and sent it to the Mogre Moenlight
customer Consult Ltd
+

Group Obijects

Example: To show activities of a particular category of a particular user within a selected
timeframe, please do the following:

(1) Select timeframe

(2) Select User

(3) Select desired Daylite user
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[ XoX ] + New @ B & ¢ F O Q Search
Time&Budget -
fa} Home < & Activities $ [ timeframe:  Month & April 2015 { Today » @ @ M
» B calendar
» [l contacts [ Grouping: | Off | % | B El B | T O b M ®
» & Objectives
P o Tasks User Activities between 01.04.2015 and 30.04.2015 created on 08.05.2015
Notes & Emall Timeframe: 01.04.2015 - 30.04.2015
» [ Forms.
v I Groups Chart
IEJ Al Groups.
@ Reports
Number of Activities Aaron Mccarthy
© TimeaBudget Total Duration Anna Sanchez
Jerry Price
Total Billable Duration Eugene Moore
Hilda Harmon
Total Gost Johnny Lee
Raquel Bush
Total Charge Richard Johnson
‘Sammy Norton
Alberto Hicks  m—
0 1 2 3 4 6 7 10 11 12 13 14 15 16
Activities Export.
Person — Gategory — Gount ~ Duration — Ratio — Gost — Charge —
122:00 0% 4037,67% 8.85500%
| A Aaron Mecarthy Client 15 29:13 86% 93458 § 3120008
| A ey Price Giient 7 7:29 5% 270,83 § 83750
| 4 Annasanchez Hot 7 2:59 34% 100,33 § 150,00%
| 1 FEugene Moore Hot 6 429 67% 154,58§ 450,00 §
| AL Sammy Norton Interested Party 5 0:32 0% 1458
| A Richard Jonnson Giient 5 a4 43% 156,50 240,00 §
+

Filter has been applied

ece + New e ms ¢ B D Q Search
Time&Budget '
{2t Home < & Activities < timeframe:  Month < April 2018 < Teday > ® O
» B Calendar
» B conacts Grouping: @  m L B T|O S
» @ Objectives [
» o Tasks User Activities between 01.04.2015 and 30.04.2015 created on 08.05.2015
ClLrmeet Timeframe: 01.04.2015 - 30.04.2015
» [ Forms.
w I Groups Chart
I A1 Groups.
& Repons No chart available
© Time&Budget -
Activities Export...
— Category — Name — Keywords — User — Person — Company —  Project — Opportunity —  Date w Duration — Cost — Charge — Billed —
20113 934,588 3120008
Development  Mocarthy & Co Inc. Accountancy Firm - Kevin Aaron Mecarthy & o Mocarthy & Go - 24.04.15 400 12000%  480,00%
© Development Website: Bugs Gregory Mecarthy  Inc. Website
identifizieren und benheben Accountancy development
Firm
Administration  Mocarthy & Co Inc. Accountancy Firm - Jose Miller,  Aaron Mecarthy & Co Mocarthy & Co - 20.04.15 200 70008
© Development Website: Implementation Kevin Mecarthy  Inc. Website
of the transfer Gregory Accountancy development
Firm
Consuting Final discussion Jose Miller  Aaron Mecarthy & Co 17.04.15 100 40008 150,008
© Mocarthy  Inc.
Accountancy
Firm
Administration  Mocarthy & Go Inc. Accountancy Firm - Kendra Aaron Mecarthy & o Mocarthy & Go - 16.04.15 080 1000%
© Development Website: Set delivery date Montgomery ~ Mccarthy  Inc. Website
Accountancy development
Firm
T Development  Mccarthy & Co Inc. Accountancy Firm - Kevin Aaron Mecarthy & Co Mocarthy & Co - 14.04.15 100 30008  12000$

To add a filter for the category:

(1) Select one of the shown Categories
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[ JoN } + New Al © B0 ¥ B Q Search
Time&Budget +
fa} Home < & Activities $ timeframe:  Month & April 2015 { Today » @ M
» B calendar
> D Cortacte copng [on | & @ 2 W |T | O e [Emme N
» & Objectives 1
> of Tasks User Activities between 01.04.2015 and 30.04.2015 oreated on 08.05.2015
LY esnE Timeframe: 01.04.2015 - 30.04.2016
» [ Forms.
v I Groups Chart
IEJ Al Groups.
® Ropons No chart avallable
@ Time&Budget .
Activities Export..
— Category — Name — Keywords — User — Person — Company — Project — Opportunity — Date w Duration — Cost — Charge — Billed —
20113 93458%  3.120,00$
Development  Mccarthy & Co Inc. Accountancy Firm - Kevin Aaron Mccarthy & Go Mocarthy & Co - 24.04.15 400 120,008 480,008
© Development Website: Bugs Gregory Mecarthy  Inc. Website
identifizieren und beheben Accountancy development
Firm
. Admin io! Mccarthy & Go Inc. Accountancy Firm - Jose Miller, Aaron Mccarthy & Go Mccarthy & Go - 20.04.15 2:00 70,00 $
‘ Development Website: Impiementation Kevin Mecarthy  Inc. Website
of the transfer Gregory Accountancy development
Firm
‘Consulting Final discussion Jose Miller Aaron Mccarthy & Co 17.04.15 1:00 40,00 $ 150,00 §
Mecarthy  Inc.
[C] Accountancy
Firm
Administration  Mocarthy & Co Inc. Accountancy Firm - Kendra Aaron Mccarthy & G Mocarthy & Co 16.04.15 0:30  10,00$
© Development Website: Set delivery date Montgomery ~ Mecarthy  Inc. Website
Accountancy development
Firm

Diagram Options

The following diagram options are available

1. Number of activities

2. Total duration

3. Total duration of billable activities

4. Total of costs

5. Total of proceeds

Mecarthy & Go

Mccarthy & Go -
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e0ce + New [l

®@ B e F O Q
Time&Budget
fa} Home < & Activities 2 timeframe: Month & April 2015 < Today | > =]
» B calendar
» [ Contacts Gouping: Of % | L B | T O h o
» & Objectives
P o Tasks User Activities between 01.04.2015 and 30.04.2015 created on 08.05.2015
W .
> B otes & Emai Timeframe: 01.04.2015 - 30.04.2015
» [ Forms.
v IR aroups Chart
IEJ Al Groups.
@ Reports
imeaBudget Bennie Brown |
emn Total Duration
Mill |
Total Billable Duration &
Total Gost Kevin Gregory N
Total Gharge Kendra Montgomery |
pawn Klein [N
o 20 40 60 80 100 120 140 160 180 200
Activities Export
user — Count Duration — Ratio — Gost — Charge —
184:41 6% 5.993,08 % 11.07500%
| CB Bennie Brown 182 4111 0% 1.029,58
| CB Jose Miller 63 78:33 56% 2.142,00$ 5.865,00
| [B Kevin Gregory 17 38:00 95% 1.140,00 432000%
| [B Kendra Montgomery 15 17:27 0% 349,00 §
| £B Dawn Klein 7 9:30 63% 33250 § 900,00 §
184:41 6% 599308 $ 11075008
+

Project Tresholds

If you have applied thresholds to projects, you can keep track of them here. To do so, select

report Project Thresholds (1) in the global part (Daylite sidebar) of Time&Budget.

Your projects are being grouped by time and/or financial thesholds depending on which
help you to recognize projects

thresholds have been applied to a given project. Color codes

that exceeded their thresholds at a glance.

Display or hide available columns

Export the visible table as a CSV or Excel file, print it or save it as a PDF file
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e0e + New o e m e ¢ B O Q Search

Time&Budget ‘ +

fit Home ¢ |PrmmThreslm\ds CQ. ® O

» ¥ Calendar

» & Contacts

v & Objectives
E My Active Projects
Ed My Active Opportu... Project Thresholds
Al Projects
© A Opportunities Time Thresholds

» (3 My objectives.
T Suspendst Project — Owner — Category — No.Act. — Budget — Used Budget — Rem.Budget —  Cost — Charge —  Thrs. w

T, Finished next 7 days

e, Open Projects

6 open chances T !l Mccarthy & Go - Website development Jose Miller Development 10 25:00 23:30 1:30 720005 2520008 2/3

6, Lost chances
» o Tasks 10 25:00 23:30 1:30 720,00% 2520,008

10 25:00 23:30 1:30 720,00$ 2.520,00%

» [B Notes & Email

» 5] Forms
v I Groups Project — Owner — Category — No.Act. — Budget — Used Budget — Rem. Budget — Charge —  Thrs. w

Financial Thresholds

I 16 2083,008 3.240,00
@ Reports

© Timeas: | [ ! Mccarthy & Go - Website development Jose Miller Development 10 500,00 $ 720,00 § -220,00% 2520005

| *[ Craig Rogers - Consulting Jose Miller Consulting 6 3.500,00 326,50 § 673508 720005

16 400000 % 2.09300% 453,50 % 3.24000%

Data Quality

Choose the Data Quality report to check which appointments and tasks missing important
information. The report shows activities without category and without linked objective.

(1) Select Data Quality

(2) Back & forward

(3) Select timeframe

(4) Print current view

(5) Filter by Daylite user

(6) All activities without Daylite category
(7) All activities without linked objective

Click an appointment or task to open the particular activity in the main Daylite window.
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e B e ¢ F I

Q Search

e0ce + New
@ Time&Budget
{2t Home < ¢ DataQuality 2 @ [lm-ir-m-: Year 2015 < Today > D 9
» B calendar
» [ contacts Data Quality Report created on 08.05.2015
O Timeframe: 01.01.2015 - 31122015

B4 My Active Projects
Ed My Active Opportu...
F A Projects

@ AnOpportunities

User Filter

@ Alle users @ Jose Miller

» (53 My objectives
T, Suspendet

Expenses without cost

(© Gonsuiting

HE&P Final discussion

Jose Miller

T, Finished next 7 days
T, Open Projects — Name — Owner — Objectives — Date v
©,, open chances
o B Untitled Note Jose Miller T Lois Frank Auditor - Consulting 08.05.15
)., Lost chances
» o Tasks B invoice Jose Miller 07.05.15
Notes & Email
» B Forms Activities without Category
v I8 Grovps — Name — Owner — Oblectives — Date v Time — Cost —
IE] All Groups
& Reports 200 80,008
_ + Paul Johannes - Gonsulting: Settle Appointment Jose Miller T Craig Rogers - Gonsulting 08.05.15
(© Untitled Appointment Jose Miller 07.05.15 1:00 40,005
(©  Untitied Appointment Jose Miller 07.05.15 100 40,00%
2:00 80,00 %
@' Activities without linked Objective
— Gategory — Activity — Owner — Date v Time — Gost —
25:20 101333%
| B Expense Invoice Jose Miller 07.05.15
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Groups

Reports on Groups

Opposed to the Time&Budget tab available in projects, opportunities, people and
companies, the Time&Budget tab available in groups enables you analyze a freely definable
collection of objects. Four different types of groups are being supported: groups of projects,
groups of opportunities, groups of people and groups of companies. There is an individual
report available for every particular type of group.

If you would like to run a report on a selection of clients for example, please do the
following:

1. Create an new group in Daylite
2. Add the desired clients to the newly created group
3. Select the Time&Budget tab

4. Select the Person Group Internal report (Next time you click the Time&Budget tab within
this group, this report will be preselected)

1. Select a Daylite group and click the Time&Budget tab
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e0ce

+ New Group

-4 0

e msce O BHls

Q Search

All Groups

+

£} Home
» B calendar
» [ contacts
v & Objectives
B4 My Active Projects
E§ My Active Opportu...
F A Projects
@ AnOpportunities
» (53 My objectives
T, Suspendet
T, Finished next 7 days
T, Open Projects
©,, open chances
9, Lost chances
P o Tasks
» B Notes & Email
» B Forms.
¥ IR Groups
IE A Groups
& Reports
© Time&Budget

Arranged by Name &

Group || Time&Budget

& +

My Glients

My Project

ﬁ My Clients

category @ Marketing

people (L Aaron Mocarthy [»

(L Brandon Jenkins |»)
(L Brandon Peterson |»)

(L Catherine Henderson | »

All Activity +

Qal

Aaron Mccarthy
Craig Rogers.

Pedro Bowman
Catherine Henderson
Joseph Wood

Debra Brewer
Brandon Jenkins
William Washington
Brandon Peterson
Eric Foster

Kelly Ray

Richard Johnson
Rodney James
Raquel Bush

Johnny Lee

Janet Green

Hilda Harmon

Jerry Price

Todd Turner

Earlier This Year

4. Marz 2015

4. Marz 2015

4. Marz 2015

4. Mérz 2015

4. Mérz 2015

4. Mérz 2015

4. Marz 2015

4. Marz 2015

4. Marz 2015

4. Mérz 2015

4. Mérz 2015

4. Mérz 2015

4. Mérz 2015

4. Marz 2015

4. Marz 2015

4. Mérz 2015

4. Mérz 2015

4. Mérz 2015

4. Mérz 2015

[ S S Sy Sy Sy S T O O T TH THN R CEN S Say Sy Wy

= S o s
Group Overview

(1) Back & forward

(2) Refresh

(3) Group reports drop-down menu (Person, Opportunity, Company and Project)

(4) Timeframe of the report

(5) Print current view

(6) Group shown objects

(7) Group activities
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e0e + New Group ~j 0 @ @m® ¢ @ Q Search
All Groups ‘ 4
£ Home Arranged by Name & Q g. n@auugn & +-
> B Galendar e A metrame: Nome 0 e (1]
» [ contacts h
. Grouping: &
¥ & Objectives My Project L) [ P @ * =W T }@
B4 My Active Projects g
Ed My Active Opportu... (Summary for My Clients
F A Projects
All Opportunities — — n — y — s — User — v Time — — arge — —
Activi Persor ca u Date Ti Cost Ch Billed
» (5 My abjectives
T,, Suspendet 148:04 4719255  9.776008
T,
IR EED (O H&P Final discussion Hilda Harmon Consulting JoseMiller  04.05.15 1:00 40,00$ 150,00 §
T, Open Projects
B, open chances. (©  Final discussion Jerry Price derry Price Consutting JdoseMiler  01.05.15 100 4000%  150,00%
8, Lost chances
STy (©  Final discussion Johnny Lee Johnny Lee Consuiting Jose Miller  01.05.15 100 40008 150,008
» 8l Notes & Email (©  H&P Consutting Jerry Price Consuiting JdoseMiler  30.04.15 130 60008 225008
» B Forms.
(© Consutting Johnny Lee - Part 2 Johnny Lee Consuiting JossMiler  30.04.15 30 6000  22500$
v I Groups
1B Al Groups (© Appointment with Mrs. Sutton Jamie Sutton Accommodation JoseMiler  30.04.15 100 4000%
Report:
© Reports (@©  Lunch Johnny Lee Johnny Lee Sales JoseMiller 29,0415 100 40,008
© Time&Budget
(©  Closing-Meeting Ms. Dennis Wanda Dennis Consuiting Jose Miller 280415 200 8000S 300,00
(©  H&P Gonsulting - Appointment derry Price Gonsuiting JdoseMiler  28.04.15 200 8000  30000$
(©  Lunch Wanda Dennis Wanda Dennis Sales Jose Miller  27.04.15 100 40008
(@© Called Lee Simon Lee Simon Sales JdoseMiler  27.04.15 030 20008
(@ Mosanthy & Go nc. Accountancy Firn - Aston Mocarty Development Kevin 24.04.15 400 120008 480,00
Development Webste: Solve issues Gregory
©  Luncn Jonnny Lee Johnny Lee Sales Jdose Miller  24.04.15 100 4000%
(@©  H&P Consulting Jerry Price Consuiting JdoseMiler 24,0415 205 8333$ 312508
(©  Seminar - Individual Training Sutton Jose Miller, Jamie Sutton  Seminar Jose Miller  23.04.15 400 16000S 480,00

Analyzing a Group

Our example shows four projects that have been added to a group to analyze them.

The report Project Group Internal (1) has been selected

(2) Grouping of shown category

+ 2 items |

®0® +NewGroup v © &5 P O Q Soarch
All Groups ‘ 4k
£} Home Arranged by Name & Q | Group  Time&Budget o & +-
> 5 Calendar My Cli ° < & Person Group Inte... & timeframe: None < ® =
» [ contacts
. Grouping: ®
@ ovjectes I o @oves (¢ @ m T 0 |
B4 My Active Projects
£ wy Active Opportu... Summary for My Clients
T Al Projects
© Al Opportunities — Activity — Person — Category —  Keywords — User —  Date w Time — GCost — Gharge — Billed —
» [ My objectives
[T 14804 4719255 9776008
T,
AR (©  HaP Final discussion Hilda Harmon Consulting JoseMiller  04.05.15 100 40008 150,00
T, Open Projects
9, open chances ©  Final discussion Jerry Price Jerry Price Consulting JoseMiler 010615 100 40008 150008
9, Lost chances
T (©  Final discussion Johnny Lee Johnny Les Consutting JoseMiler 010515 100 4000§  15000§
» 8] Notes & Email (© H&P Gonsulting Jerry Price Gonsuting JoseMiler  30.04.15 130 6000  22500$
» 5 Forms
©  Consulting Johnny Lee - Part 2 Johnny Lee Consuliing JoseMiler  30.04.15 30 60008 225008
v I Groups
I A1 Groups (©  Appointment with Mrs. Sutton Jamie Sutton Accommodation JoseMiller  30.04.15 100 4000
© ropons (@©  Luncn Jonnny Lee Johnny Lee Sales JoseMiller  29.04.15 100 40,00$
© TimeaBudget
©  Glosing-Mesting Ms. Dennis Wanda Dennis Consulting JoseMiler 280415 200  8000$ 300008
(©  HaP Gonsulting - Appointment Jerry Price Consuliing JoseMiler 280415 200 8000§ 300008
(©  Lunch Wanda Dennis Wanda Dennis Sales JoseMiller  27.0415 100 4000
(© CalledLee Simon Lee Simon Sales JoseMiler  27.0415 030 2000
(@ Mooany &.Co nc. Accountancy Firm - Aaron My Development Kevin 24,0415 400 12000 480,00
Development Website: Solve issues Gregory
@©  Lunch Johnny Lee Johnny Lee Sales JoseMiller 240415 100 40008
©  HaP Gonsuting Jerry Price Consutting JoseMiller 240415 205 8333%  31250%
minar - Individual Training Sutton er, Jami n minar er 04, : s X
‘Seminar - Individual Training Sut Jose Miller, Jamie Sutton  Semi JoseMiller 230415 400  16000$ 48000
+ 2 items 3
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After grouping by category the report shows an overview of activities within the particular
category

(1) Filtered by category

(2) Changes the diagram

®0® +NewGow v 0 © &5 P O Q Soarch
All Groups i
£} Home Arranged by Name & Q | Group  Time&Budget & +-
> 5 Calendar My Gl ° < & Person Group Inte... & timeframe: None < (] =
» [ contacts
SO D y Project . @) Gowng: | o El = B T O h | e
B4 My Active Projects
£ wy Active Opportu... Summary for My Clients
T Al Projects
@ Anopportunities Chart
» [£3 My objectives
To Suspendst ﬂ
T,, Open Projects -
Tz Total Duration Administration  IEG—
B, open chances. )
6, tont oromoms Total Bilable Duration Consulting  IEEG——
& Total Development
B Marketing -
» 8] Notes & Email Total Charge Seminar
» B Forme Accommodation 1
[ aroups 0 20 40 60 80 100 120 140
e Category a Count — Time — Cost — Charge —
@& Repons
© TimoaBudgst 7552 2457,08% 5976005
| ¥ Accommodation 1 1:00 40,00$
| @ Administration 25 19:59 52342 %
| @ Consulting 22 33:20 129333 § 500000
| §  Development ) 23:00 710,006, 2760008
| @ Marketing 7 7.00 15250 §
| ¥ Sales 125 48:57 1.328,00 §
§  Seminar 7 16:48 672,00$. 201600%
7552 2.457,08$ 5976,00%
+ 2 items
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Data transfer and export
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Data Transfer to Invoicing Software

Time&Budget provides the unique feature to transfer registered times and costs to certain
invoicing systems. This enables you to use the times registered with Time&Budget to
invoice your clients. A list of supported invoicing systems is available here.

Setup

Time&Budget detects automatically if on of our invoicing connectors for Daylite have already
been installed. In this case external reports will show an additional button (e.g. in projects) (1)
Invoice....

®O0®  +NewPoject ~ 0 e 8¢ ¢ O EI=n a

Al Projects +
Arranged by Created + Q | Project Progress Kurs Time&Budget & +-
‘Seminar for Mrs Martinez @ Project - Print Layout & timeframe: None 2 @ # B
Preperation

Mondschein GmbH

Business consultancy Moonlight... @ @ Blstenburgstrale 35
80636 Minchen
" o Deutschiand
Seminar "Selling to decision maker” ¢ d
Acquisition iy

‘Webinterface for Johnson's Servi... ®

Deltvery Activities for Craig Rogers - Consulting 11 Mali 2015
1t Individual training Sutton
Rework Financial Summary

Financial Budget 3.500,00 €
Consumed 720,00 €
Remaining 2.780,00 €

!l Mccarthy & Co - Website devel... @

Lois Frank Auditor - Consulting ®

Time Summary
1l Seminar for Jenkins & Partner Time Budget 0:00h
Consumed 4:00h
Remaining 0:00 h
Raquel Bush Management - Seminar 1
Activities Export. Sattings:
FLMH Brown - Consulting .
Post
osterecessing Activity Category Owner Date Duration Cost Charge  Billed
Craig Rogers - Consulting -
Fine-tuning | B invoice Expense Jose Miller 07.05.15 - 18:57 0,00 € 120,00 €
Training course for Young Manag... | (@© Consulting Jose Rogers Gonsuiting Dawn Kiein 24.03.15- 11:00 200 70,00 € 300,00 €
| (@ Consuiting Joss Rogers Gonsuitting Dawn Kiein 17.08.15 - 16:00 2:00 70,00 € 300,00 €
J.Lee Business Consultancy - Se...
Rowork 400 239,00 € 720,00 €

‘Wanda Dennis Tax Consultancy -...
Rework

Pedro Bowman - Cansulting a
15 items

Transfer Registered Times

There are different options and settings regarding the transfer to the invoicing system:

(1) Select which of the companies linked with the project you would like to transfer to the
invoicing software.

(2) Define whether the prices include taxes

(3) List Select which registered activities you would like to transfer
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(4) Select which registered activities you would like to transfer

Please note: If you are using TotalsConnector, you can determine a subject and whether or not
you would like to also transfer the activities' details to the invoicing software.

Send Time&Budget Activities to Totals

gDocumant Type | Invoice Recipient | Be Craig Rogers @

Header e
o Activities [ Include Details| [ | Prices include Tax

Send Line Date Quantity Unit Cost Price
Invoice 07.05.15 1 pc 120,00 € 120,00 €
Consulting Jose Rogers 24.03.15 ; 35,00 € 150,00 €

Cancel Send to Totals

Overview Of Previously Transferred Activities

If you have already sent activities to an invoicing system, these particular activities will show a
check in the column Billed.
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®0® +NewProjest v [ 0 2 ¢ ¢ ® O El= Q Search

All Projects ‘ e
Arranged by Created # Q, | Project Progress Kurs Time&Budget & +-
Seminar for Mrs Martinez & Preject - Print Layout timeframe: None & @ # O
Preperation
Wondschein GmbH
Business consultancy Moonlight... @ BlutenburgstraBe 35
80636 Munchen
Deutschiand
Seminar "Selling to decision maker" L & o
Acquisition ", ot el
Chei
Webinterface for Johnson's Servi... o
Dell Py - "
ens Activities for Craig Rogers - Consulting 11. Mal 2015
1 Individual training Sutton
Rework Financial Summary
1l Mccarthy & Co - Website de ® F'"’m:'::'ni"::g :‘25: 3002 €
Remaining 2.780,00 €
Lois Frank Auditor - Consulting Y
Realization Time Summary
1l Seminar for Jenkins & Partner Time Budget 0:00h
Consumed 4:00h
Remaining 0:00h
Raquel Bush Management - Seminar
Activities Export.. | Invoice.. | Settings.
FLMH Brown - Gonsuiting Y
Post i
oetprocessing Activity Gategory Owner Date Duration Cost Charge
Craig Rogers - Consulting °
Fine-tuning | B Invoice Expense Jose Miller 07.05.15 - 18:57 99,00 € 120,00 €
Training course for Young Manag... | (© Gonsulting Jose Rogers Consulting Dawn Klein 24.03.15 - 11:00 2:00 70,00 € 300,00 €
(© Gonsulting Jose Rogers Consulting Dawn Klein 17.03.15 - 16:00 2:00 70,00 € 300,00 €
J.Lee Business Consultancy - Se...
Reweric 4:00 239,00 € 720,00 €
Wanda Dennis Tax Consultancy -...
Rework
Pedro Bowman - -
15 items
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Export

You would like to process your Time&Budget data in an external system but we have not

developed an appropriate connector yet?

Time&Budget provides the ability to export reports to Excel or as a CSV (comma separated

value) file.

Select Data to be Exported

In order to export data, please follow these steps:
(1) Open the report you would like to export

(2) Group or filter data if needed

(3) Hide columns you don't want to export if needed

(4) Click Export... to export the data

e0e + New o O B & ¢ F D Q Search

Time&Budget [+
{a} Home < & [Activitios )  tmotame: Mot ¢ April 2015 < Today > ¢ &
» [ Galendar
» B Contacs [cosos (o & @ 2[m| T o |@ " D
¥ & Objectives

Ed My Active Projects
Ed My Active Opportu...
Al Projects
@ A opportunities
» (27 My objectives

T,, Suspendst
T, Finished next 7 days
T,, Open Projects
9, open chances
©,, Lost chances

v o Tasks
I workist
) Not Done
©» Delegated
Done
o All Tasks
., Finished next 7 days
¥, Important!

» B Notes & Email

» 5 Forms

5] Groups
5 Al Groups

& Reports

DocumentViewer

@ Time&Budget

User Activities between 01.04.2015 and 30.04.2015

Timeframe: 01.04.2015 - 30.04.2015

Chart

Number of Activities e Agency

created on 11.06.2015

Total Duration Moore Consult LTD

Peter:

son & Partner Ct Ag
Total Billable Duration Mccarthy & Co Inc. Accountancy Firm

didloge C Agency
Total Cost i er
Total Charge Tommy Jenk
JLee Busii
Jol
0 25 H
Activities
Company — Category — GCount
| Ha H &P Communication Agency Glient 21
| Ha Moore Consult LTD Hot 20
| B Peterson & Partner Communication Agency Client 18
| Ha Mocarthy & Co Inc. Accountancy Firm Client 15
Ha didlogo Communication Agency Interested Party 12

7.5 10 125 15 175 20 225
Export...
Duration —  Ratio — Cost — Charge —
125:00 0%  414267€ 9.155,00 €
14:17 64% 511,83 € 1.362,50 €
637 30% 211,17€ 300,00 €
2:44 0% 78,83 €
28:13 86% 934,58 € 3.120,00 €
2:28 0% 63,92 €

Definition der Export-Parameter

The export dialog provides the following options:
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(1) Determine file name and location
(2) Select file format (Excel or CSV)
(3) Determine desired separator if CSV format has been selected

Save AﬁU My Export| |J -
Tags:
= E“E‘” v [ Documents & Q Search
Favorites Yesterday
E Recents 9 use >
[ Dropbox Pravious 7 Days
A &= DayliteMessages.dmg

4% Applications B layout.xcf
m Pravious 30 Days
3 Music DLApplcon
° Downloads DLApplcon128
- R DLApplcon256
com.marketcircle.Da... DLAppicons12
3 Templates DLServerAdminicon

( icon.icns
[ Time&Budget.bak " | inkedld
[ Recruiting mondschein logo
P L 0 New Folder >

Libr

=t & PDF2Daylite.dmg
ﬁj danielnauerz Y Read
1 Deskton I Readthis

Document Type
Separator m

New Folder Cancel
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Miscellaneous
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Time&Budget 1 Manual
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How to uninstall a plugin

In order to uninstall a plugin, please do the following steps:

1. Open a Finder window

o0 @ = Sebastian-B-MacBook Pro (2)
i ol R~ =~ h | O i | 5

~

v

jill
¢

Favorites Name ~  Date Modified Size Kind

22 Dropbox » & Macintosh HD Yesterday 12:46 210,86 GB  Volume
> @ Network - - Neighb

iCloud Dri
el » (%) Remote Disc = ~ Volume

Box Sync
0 Downloads
@} AirDrop

i1 Bilder

= Schreibtisch
H Filme

#2: Programme
@ Dokumente
EI Anleitungen

Devices H Sebastian-B-MacBook Pro (2)

® 3 items

2. Click Go in the Finder menu, hold down the ~- [alt] key and select Library
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@ Finder File Edit View [Belsl Window Help
Back [
Forward )
Enclosing Folder

E All My Files

[¥ Documents {+380
= Desktop 8D
© Downloads

15t Home
£ Library
[ Computer
(@) AirDrop 88
@ Network 48K
¢ iCloud Drive {38l
# Applications 1+ 3A
¥ Utilities

Recent Folders

Go to Folder...
Connect to Server...

HK

7. Oktober 2014 14:04 -
» [ Address Book Plug-Ins 4, Juli 2014 09:34 --
3 iCloud Drive » [ Application Scripts 12. Mal 2014 15:41
5 Box Syne > Application Support Heute 14:18 =
© Downloads » [ Assistant 8. November 2013 16:05 - Ordner
) » [ Assistants 15. Dezember 2012 12:52 == Ordner
@ Airdrop » [ Audio 15. Dazember 2012 12:52 - Ordner
[i® Bilder » [ Autosave Information Gestern 10:14 -~ Ordner
B8 Schreibtisch » [ Caches Heute 14:31 --  Ordner
» [ Calendars 22, Oktober 2014 11:05 == Ordner
3 Filme » |1 chat hipchat.com 3. Dezember 2013 11:38 - Ordner
#% Programme » [ ColorPickers 15. Dezember 2012 12:52 --  Ordner
» [ Colors 17. Oktober 2014 00:14 - Ordner
(! Dokumente » [ ColorSync 26. Oktober 2014 11:48 -~ Ordner
E2) Anleitungen » |1 com.apple.nsurisessiond Heute 12:39 -~ Ordner
S _»_[F Containers 16, Oktober 2014 17:08 == Qrdner
&l Macintosh HD » [ Benutzer » 4 basti » [l Library + [ Application Support

4. Navigate to com.marketcircle.Daylite4
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[ Application Support

L 6 W=D =0 = W) Q, Suchen

£3 Dropbox » [ com.apple.QuickLook 30, Oktober 2014 10:13 - On
» [0 com.apple.sbd 23. September 2014 16:54 - On
& iCloud Drive » [ com.apple.spotlight Heute 14:18 - On
[ Box Sync " com.apple.spotlight.Shortcuts Heute 14:18 44KB Do
© Downloads » [ com.apple.TCC Heute 14:30 = On
® AiDrop » [ com.boinx.Mousepose.Mac 26. Oktober 2014 10:28 o
com.markatcircla. Daylited 10. Oktober 2014 16:02 - On
i) Bilder » B9 com.zeptolab.cuttheropehd 1. August 2013 11:10 - O
Sehreibtisch » B Console 10. Januar 2013 17:15 -~ On
» [ CrashReporter Heute 12:52 -=  On
H Fime » [ Dialectic 12, Juni 2014 15:17 S
#%; Programme » [0 DiskDril 24, Juli 2013 21:32 - o
(8 Dokumente » [ Dock Gestern 12:08 - O
N » | Dropbox 23. September 2014 16:54 - O
Anleitungen _» [ Dropzone 3 22. Juli 2014 09:08 - o

&l Macintosh HD » [l Ber + & bas » [ Libr » [ Application Support = [l com.marketcircle. Dayiit

| 1 von 86 ausgewahit, 69,21 GB verfugbar

5. Navigate to Plugins

£2 Dropbox

<7 iCloud Drive

[ Box Sync

@ Downloads

@) Airbrop

i@ Bilder

[ Schreibtisch

H Filme

#; Programme

5! Dokumente

[ Anleitungen
Gerdite

Q Suchen

Anderungsdatum

» 9 Backup 16. Juni 2014 08:42 -
' GeoFind.lic 10. Oktober 2014 16:02 825 Byte
B9 Logs Heute 14:36 -

787 Byte Dg

: ProductivityTools.lic 11. August 2014 16:13

% storage.dipdb 24, Juli 2014 19:51 624GB St
» 3 Templates 16. Juni 2014 08:25 - or
» [ Time&Budget 4. September 2014 16:36 -- O

| WebConnectorlic 31, August 2014 11:57 769 Byte  Dg

& Macintogh HD » [l Bern: » 4 basti » [l Libr: » [l App' » [ com.marketcircle.Daylited » [ Plugins

1 von 9 ausgewahit, 69,21 GB verfdgbar

6. Delete the appropriate plugin
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[ JoN ) [ Plugins
(<] > ] = ==Ecmlun,¢~,gv. ull E=0 B=3 Bo8 Q Search
Favaiitee Name ~  Date Modified Size
23 Dropbox ® FoneConnector.daylite-plugin 30 Oct 2014 21:34 5,6 MB
[+ GeoFind dayiite-plugin__| nm!J
& iCloud Drive ® ProductivityTools.daylite-plugir gg o , BiKB
£S5 Box Sync ® ReportCenter.daylite-plugin Show Package Contents 00 KB
o Downloads ™ TimeAndBudget.daylite-plugin 6 MB
@ A = WebConnector.daylite-plugin Mave to Trash 4 MB
Get Info
o B“d"' ) Compress "GeoFind.daylite-plugin” |
5 schreibtisch Burn “GeoFind.daylite-plugin” to Disc...
B Filme Duplicate |
#% Programme e 4 =
& Quick Look “GeoFind.daylite-plugin |
Dokumeante Share »
S Anleitungen Copy “GeoFind.daylite-plugin” |
Davices |- Show View Options L
[ Sebastian-B-MacB... | & Macintosh HD - By U + 4 b + i plugin
1 of & selected, 37,746 18gS...

7. Restart Daylite

e 00O O

Send files with TeamViewer
Reveal in Finder
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